Microsoft

Exam Questions 70-779

Analyzing and Visualizing Data with Microsoft Excel (beta)
NEW QUESTION 1
You have a table that contains data relating to exam candidates and their associated scores. You need to visualize the exam data by separating the data into quartiles. The visualization must display the mean score and must identify any outliers. Which type of chart should you use?

A. line
B. histogram
C. pie
D. box and whisker

Answer: D

Explanation:

NEW QUESTION 2
You have a table in a Microsoft SQL Server database that has more than 5 columns. A sample of the data and some of the columns are shown in the following table.

<table>
<thead>
<tr>
<th>OrderID</th>
<th>OrderDate</th>
<th>ClientID</th>
<th>ClientName</th>
<th>ClientPhone</th>
<th>ProductID</th>
<th>ProductName</th>
<th>ProductWeight</th>
<th>OrderAmount</th>
</tr>
</thead>
<tbody>
<tr>
<td>123</td>
<td>2017/01/05</td>
<td>156</td>
<td>ClientA</td>
<td>555-555-5555</td>
<td>605</td>
<td>Product1</td>
<td>10</td>
<td>100</td>
</tr>
<tr>
<td>456</td>
<td>2017/01/05</td>
<td>156</td>
<td>ClientA</td>
<td>555-555-5555</td>
<td>605</td>
<td>Product1</td>
<td>10</td>
<td>250</td>
</tr>
<tr>
<td>789</td>
<td>2017/01/05</td>
<td>156</td>
<td>ClientA</td>
<td>555-555-5555</td>
<td>604</td>
<td>Product2</td>
<td>12</td>
<td>100</td>
</tr>
<tr>
<td>101</td>
<td>2017/01/05</td>
<td>156</td>
<td>ClientB</td>
<td>555-555-5555</td>
<td>604</td>
<td>Product2</td>
<td>12</td>
<td>175</td>
</tr>
</tbody>
</table>

The table contains more than two million rows. You have 100 clients and 10 products. You need to load the data to Excel. The solution must minimize the amount of memory used by the model. What should you do?

A. Move the database to a Microsoft Azure SQL database
B. Load the table to the data model.
C. Load the data to the data model as three tables named Clients, Orders, and Product
D. Ensure that each table has only the relevant column
E. Remove duplicate rows from Clients and Products.
F. Load the data to one worksheet.
G. Load the data to three worksheets named Clients, Orders, and Product
H. Ensure that each worksheet has only the relevant column
I. Remove duplicate rows from Clients and Products.

Answer: B

NEW QUESTION 3
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.

Start of repeated scenario
You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The table are loaded to the data model, but the data is not loaded to any worksheets. The data model is shown in the Data Model exhibit. (Click the Exhibit button.) Your company has 100 product subcategories and more than 10,000 products.
Certshared now are offering 100% pass ensure 70-779 dumps!
https://www.certshared.com/exam/70-779/ (117 Q&As)

You have a PivotChart that uses Manufacturer as the axis and the sum of SalesAmount as the values. You need to ensure that only the top 10 manufactures appear in the chart.

What should you do?

A. Change the format of the SalesAmount field.
B. Create a calculated column.
C. Configure the Value Filters.
D. Summarize the SalesAmount field by Max.

Answer: C

Explanation:

NEW QUESTION 4
You create an Excel workbook named SalesResults.xlsx. You create a workbook query that connects to a Microsoft SQL Server database and loads data to the data model. You create a PivotTable and a PivotChart.
You plan to share SalesResults.xlsx to several users outside of your organization.
You need to ensure that the users can see the PivotTable and the PivotChart when they open the file. The data in the model must be removed.
What should you do?

A. Run the Document Inspector.
B. Save the workbook as an Excel Binary Workbook (.xlsb).
C. From Query Editor, open the Data Source Settings and delete the credentials.
D. Modify the source of the query.

Answer: C

NEW QUESTION 5
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result these questions will not appear in the review screen.
Your company has sales offices in several cities.
You create a table that represents the amount of sales in each city by month as shown in the exhibit.

End of repeated scenario.
You need to ensure that all values lower than 250 display a red icon. The solution must ensure that all values greater than 500 display a green icon.

Solution: You modify the conditional formatting rule, and then set a new value for the yellow icon. Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 6

You have an Excel workbook query that loads data to a worksheet and the data model. You need to ensure that the data is refreshed whenever you open the workbook.

What should you do?

A. From the File tab, click Option, and then modify the Data option.
B. From the File tab, click Options, and then modify the General options.
C. From the Data tab, click Queries & Connections, and then edit the properties of the query.
D. From the Power Pivot model, modify the Table Behavior setting.

Answer: C

Explanation:

NEW QUESTION 7

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You have an Excel workbook that contains a table named Table1. A sample of the data in Table1 is shown in the following table.

You need to create a PivotTable in PowerPivot as shown in the exhibit.
Solution: You create a hierarchy named Products that contains ProductCategory.
Solution: You create a measure named Products the uses the DataTable DAX Function. You add a PivotTable. You drag products to the Rows field. You drag Price to the Values field.

Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 8

Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.

Start of repeated scenario

You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The tables are loaded to the data model, but the data is not loaded to any worksheets. The data model is shown in the Data Model exhibit.
Your company has 100 product subcategories and more than 10,000 products. End of repeated scenario.

You need to create a simplified view of the workbook for some users. The simplified view must only display data from FactSales, DimProduct, and DimDate.

What should you do in the data model?

A. Click Hide from Client Tolls for all the tables except FactSales, DimProduct, and DimDate.
B. Create a new perspective.
C. Modify the Table Behavior settings for FactSales, DimProduct, and DimDate.
D. Add the columns from FactSales, DimProduct, and DimDate to the Default Field Set.

Answer: A

NEW QUESTION 9

You have a model that contains data relating to corporate profits. The model contains a measure named Profit.

You need to create a PivotTable to display the Profit measure in three different formats by using the Show Value As feature. The PivotTable must produce the results shown in the following table.

How should you configure the Show Value As feature for % Profit of Annual Total and % profit of Grand Total? To answer, select the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.
A. Mastered
B. Not Mastered

Answer: A

Explanation:
% Profit of Annual Total: % of Parent Total
% Profit of Grand Total: % of Column Total

NEW QUESTION 10
You have a data model that has the following tables.

<table>
<thead>
<tr>
<th>Table name</th>
<th>Column name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales</td>
<td>Date</td>
</tr>
<tr>
<td></td>
<td>SalesAmount</td>
</tr>
<tr>
<td></td>
<td>Product</td>
</tr>
<tr>
<td>Date</td>
<td>Date</td>
</tr>
<tr>
<td></td>
<td>Year</td>
</tr>
<tr>
<td></td>
<td>Month</td>
</tr>
<tr>
<td></td>
<td>Day</td>
</tr>
</tbody>
</table>

You create a PivotTable. The data displayed in the PivotTable is shown in the following table.

<table>
<thead>
<tr>
<th>Row Labels</th>
<th>Sum of SalesAmount</th>
<th>% of Grand Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>2011</td>
<td>$8,341,224,364.83</td>
<td>100.00%</td>
</tr>
<tr>
<td>2012</td>
<td>$8,341,224,364.83</td>
<td>100.00%</td>
</tr>
<tr>
<td>2013</td>
<td>$8,341,224,364.83</td>
<td>100.00%</td>
</tr>
<tr>
<td>2014</td>
<td>$8,341,224,364.83</td>
<td>100.00%</td>
</tr>
<tr>
<td>2015</td>
<td>$8,341,224,364.83</td>
<td>100.00%</td>
</tr>
<tr>
<td>2016</td>
<td>$8,341,224,364.83</td>
<td>100.00%</td>
</tr>
<tr>
<td>2017</td>
<td>$8,341,224,364.83</td>
<td>100.00%</td>
</tr>
<tr>
<td>Grand Total</td>
<td>$8,341,224,364.83</td>
<td>100.00%</td>
</tr>
</tbody>
</table>

You need to ensure that the correct data is displayed. What should you do?

A. Modify the workbook connections
B. Configure the PivotTable Options
C. Modify the relationships
D. Refresh the data connection

Answer: C

NEW QUESTION 11
You have the PivotTable shown in the following exhibit.
You need to display only rows in the PivotTable in which the sum of LineTotal is greater than 100. What should you do?

A. From Row Label, configure a Label filter.
B. Add a slicer for LineTotal and select the values from the slicer.
C. From Row Label, configure a Value Filter.
D. Add LineTotal to the Filters area of PivotTable Field
E. Configure the Filters value.

Answer: B

NEW QUESTION 12
You create a PivotTable and a Pivot Chart as shown in the following exhibit.

![PivotTable and PivotChart](image1.png)

You need to decrease the number of columns in the PivotChart to six. What should you do?

A. Right-click the PivotChart, click Format Axis, and then change Interval between marks to 2.
B. Right-click the PivotTable, click Group, and then change By from 10 to 20.
C. Right-click the PivotChart, click Select Data, and then remove five of the bins from the Horizontal (Category) Axis Labels.
D. Change the chart type to Histogram.

Answer: B

NEW QUESTION 13
Note: This question is part of a series of questions that use the same scenario. For your convenience is repeated in each question. Each question presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.

Start of repeated scenario
You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The tables are loaded to the data model, but the data is not loaded to any worksheets. The data model is shown in the Data Model exhibit.

![Data Model Exhibit](image2.png)

Your company has 100 product subcategories and more than 10,000 products. End of repeated scenario.

You need to create a chart as shown in the following exhibit.

![Chart](image3.png)
Which field should you use for each area? To answer, drag the appropriate fields to the correct areas. Each field may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Axis: Month Year Legend: ChanelName Values: SalesAmount

NEW QUESTION 14
You have a query that retrieves the following data.

<table>
<thead>
<tr>
<th>Vendor_ID</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>110</td>
<td>10</td>
</tr>
<tr>
<td>110</td>
<td>10</td>
</tr>
<tr>
<td>110</td>
<td>5</td>
</tr>
<tr>
<td>110</td>
<td>5</td>
</tr>
<tr>
<td>111</td>
<td>3</td>
</tr>
<tr>
<td>111</td>
<td>2</td>
</tr>
<tr>
<td>111</td>
<td>3</td>
</tr>
<tr>
<td>112</td>
<td>1</td>
</tr>
<tr>
<td>112</td>
<td>1</td>
</tr>
<tr>
<td>113</td>
<td>10</td>
</tr>
</tbody>
</table>

You need to configure the query to ensure that the data appears as shown in the following table.

<table>
<thead>
<tr>
<th>Vendor_ID</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>110</td>
<td>30</td>
</tr>
<tr>
<td>111</td>
<td>8</td>
</tr>
<tr>
<td>112</td>
<td>2</td>
</tr>
<tr>
<td>113</td>
<td>10</td>
</tr>
</tbody>
</table>

What should you do?
A. From the Transform tab, use the sum function on the Vendor_ID column
B. Group by Vendor_ID and add a SUM aggregation
C. Unpivot the table on the Vendor_ID column
D. Pivot the table on the Vendor_ID column

Answer: B

NEW QUESTION 15
You have a PivotChart template named Template1. You add a PivotChart to a worksheet.
You need to apply the template to the PivotChart. What should you do?
A. On the Design tab, click Change Chart Type.
B. On the Format tab, click Format Selection.
C. Right-click the chart and then click PivotChart Options.
D. Right-click the chart and then click Format Chart Area.

Answer: A

Explanation:
1. Click the chart
2. On the Charts tab, under Change Chart Type, click Other, and then under Templates, click the chart template that you created.

NEW QUESTION 16

You have a workbook query that gets data from a table in a Microsoft Azure SQL database. The table has a column named Phone. The values in Phone are in a format of 999-999-9999. The first three digits of each phone number represent the area code, and the rest of the digits represent the local phone number. You need to split the Phone column into two columns. The first column must contain the area code, and the second column must contain the local phone number.

How should you complete the query? To answer, drag the appropriate values to the correct targets. Each value may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation:
=Table.AfterDelimiter('#Changed Type',
Phone.Splitter.SplitTextByEachDelimiter({'-'},QuoteStyle.Csv,false),{'Area Code','Local Phone'})
=Phones.AfterDelimiter('#Changed Type',
Phone.Splitter.SplitTextByEachDelimiter({'-'},QuoteStyle.Csv,false),{'Area Code','Local Phone'})

NEW QUESTION 17

You have a workbook query that retrieves data from a table named Users. Users contains a column named PhoneNumber. The following is a sample of the data in PhoneNumber.

514 555 0169
1 (11) 500 555-0122
128 555-0148
819 555-0186
1-996-555-0192
+1 138-555-0156
556-555-0192

You need to create a custom column that contains the data in PhoneNumber in the format of 999-999-9999. The following is a sample of the desired data.

514-555-0160
500-555-0122
128-555-0148
819-555-0186
996-555-0192
138-555-0156
556-555-0192

How should you complete the Query Editor formula? To answer, drag the appropriate values to the correct targets. Each value may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A
NEW QUESTION 18
You have a query that retrieves customers and their locations. You have a sample of the data as shown in the following table.

Additional customers and locations are added frequently. You need to transform the data as shown in the following table.

What should you do?

A. Select the Locations columns and then select Split Column by Delimiter. 
B. Use a comma as the delimiter and split into rows. 
C. Select the Locations columns and then select Split Column by Delimiter. 
D. Use a comma as the delimiter and split into columns. 
E. Select the Customer columns, and then click Unpivot Columns. 
F. Select the Customer columns, and then click Unpivot Other Columns.

Answer: A

NEW QUESTION 19
You have a data model in Excel. You export the data and the data model into a dataset in the Microsoft Power BI service. What can you use to modify the data model that is published to the Power BI service?

A. Microsoft Power BI Desktop 
B. Excel and the Microsoft Power BI service 
C. Excel only 
D. the Microsoft Power BI service only

Answer: A

NEW QUESTION 20
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution. After you answer a question in this section, you will NOT be able to return to it. As a result these questions will not appear in the review screen.
You have the following data.

<table>
<thead>
<tr>
<th>OrderDate</th>
<th>OrderNumber</th>
<th>ProductName</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/28/2018</td>
<td>998989</td>
<td>Product1</td>
<td>10</td>
</tr>
<tr>
<td>1/28/2018</td>
<td>998990</td>
<td>Product1</td>
<td>22</td>
</tr>
<tr>
<td>1/29/2018</td>
<td>998991</td>
<td>Product2</td>
<td>21</td>
</tr>
<tr>
<td>1/29/2018</td>
<td>998992</td>
<td>Product3</td>
<td>43</td>
</tr>
<tr>
<td>1/29/2018</td>
<td>998993</td>
<td>Product2</td>
<td>56</td>
</tr>
<tr>
<td>1/29/2018</td>
<td>998994</td>
<td>Product3</td>
<td>12</td>
</tr>
</tbody>
</table>

You need to retrieve a list of the unique ProductName entries. Select the ProductName column, and then click Group on the Data tab. Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 21

......
Thank You for Trying Our Product

We offer two products:

1st - We have Practice Tests Software with Actual Exam Questions

2nd - Questions and Answers in PDF Format

**70-779 Practice Exam Features:**

* 70-779 Questions and Answers Updated Frequently
* 70-779 Practice Questions Verified by Expert Senior Certified Staff
* 70-779 Most Realistic Questions that Guarantee you a Pass on Your First Try
* 70-779 Practice Test Questions in Multiple Choice Formats and Updates for 1 Year

100% Actual & Verified — Instant Download, Please Click

[Order The 70-779 Practice Test Here](https://www.certshared.com)